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Chapter 1: Getting Started
 

This document is a guide to implementing a high availability solution for 
BlackBerry Enterprise Server (hereafter referred to as BES) Versions 4.0 and 4.1 
and the underlying DB infrastructure of Microsoft SQL Server (MSDE is also 
supported), based on WANSyncHA replication to a remote secondary server(s) 
with automated switchover and client redirection in the event of critical failure. 

Please review this guide, as well as each procedure, before starting in order to 
ensure you have the appropriate resources and permissions to carry out a given 
task.

About BlackBerry Enterprise Server
BlackBerry Enterprise Server (BES) is becoming a critical component of the 
enterprise communications infrastructure in support of mobile productivity. If 
disaster should strike, whether in the form of a hurricane, a blackout, or far more 
likely, a virus attack or software or user error, your ability to respond well to the 
crisis can make the difference between a bright future and the end of your 
business. At the very least, you are likely to incur significant costs in lost 
business and, perhaps more importantly, lost confidence by your customers, 
investors, and other stakeholders. BlackBerry disaster recovery is not just about 
insurance. It is about maintaining your employees' productivity wherever they 
are and it is about maintaining your competitive edge. The WANSyncHA solution 
for BlackBerry high availability is designed to give you that edge.

We offer a customized solution for BlackBerry high availability (HA) using the 
award-winning WANSyncHA for SQL switchover solution with asynchronous 
real-time replication and automated server switchover and switchback to 
provide cost-effective business continuity for BlackBerry Server on both 32- and 
64-bit Windows servers as well as MSCS clusters.

Related Documentation
Use this guide along with the WANSync User Guide and WANSyncHA SQL Server 
Operations Guide.
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The BlackBerry HA Solution
The BlackBerry HA Solution
As most BlackBerry administrators are well aware, configuration information 
regarding BES is stored almost entirely in the configuration database. This 
information is critical for proper BES operation, and is also relied upon by 
WANSyncHA for a successful Switchover. This dependency makes SQL and BES 
a platform that is tied together and, in regards to high availability, managed 
together. For this reason, the operations guide covers both SQL and BES HA as 
a single solution. This solution also covers configurations in which multiple BES 
servers are sharing the same SQL configuration database (i.e., BESMgmt). In 
this case all attached BES servers are switched over simultaneously with the 
BESMgmt database via WANSyncHA for SQL.

Important! This document does not cover e-mail server high availability 
(BlackBerry supports only MS Exchange for e-mail). High availability for those 
servers is covered under their own scenario and are outside the scope of this 
operations guide.

Requirements 
This section describes the requirements for running WANSyncHA for BES.
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Requirements
Infrastructure

To implement high availability using WANSyncHA, you must 
have/implement the following:

Two servers running Windows Server 2000 or 2003

An instance of SQL 2000 or 2005 installed on each server

– Both servers should have the same SQL version, service packs and hot 
fixes installed

– Both servers should hold identical SQL Server instances, i.e., default or 
named

– Drive letters containing database files should be identical on both 
servers

– The full path to the default system database of each instance should be 
identical on both servers

Verify that the port defined in the Network Configuration TCP/IP properties 
of the SQL instance(s) is assigned statically and is identical on both master 
and replica. What port is used is not important, they just need to match on 
both master and replica SQL servers.

Statically assign all IP addresses (DHCP-assigned IP addresses on the 
master or replica server are not supported)

Verify that the port defined in the Network Configuration TCP/IP properties 
of the SQL instance(s) is assigned statically and is identical on both master 
and replica (The port that is used is not important -- they just need to match 
on both master and replica SQL servers)

The SQL server in question is not a domain controller or DNS server
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Requirements
Two servers running Windows Server 2000 or 2003 for BES can be the same 
servers used for SQL/MSDE as described above (one is the current 
production BES server and the other is for the new standby, replica, server)

Important! BES must be installed only on the production BES server(s) 
prior to starting the procedure described in this guide. If you already 
installed BES on a second server you intend to use as a replica, uninstall BES 
from that server before proceeding.

Both servers should have identical service packs and hot fixes installed

Installation software for BES v4.0 or 4.1 and any service packs or fixes 
currently applied to your production BES server

This high availability solution is designed around the nine BES services, 
please verify that all services exist and are functioning properly on all 
production BES servers before starting implementation:

– BlackBerry Server Alert

– BBAttachServer

– BlackBerry Controller

– BlackBerry Database Consistency Service (default startup type may be 
disabled and is normal)

– BlackBerry Dispatcher

– BlackBerry Mobile Data Service (v4.0) OR BlackBerry MDS (v4.1)

– BlackBerry Policy Service

– BlackBerry Router

– BlackBerry SyncServer (Synchronization Service)

For multiple BES servers: 

– For each additional BES server connected to the same SQL instance you 
wish to protect, another stand-by (replica) BES server is required for 
Switchover. All the considerations applying to the first BES server pair 
apply to any additional server pairs. There is no limit to the number of 
BES servers that can be protected, as long as they are all connected to 
the same protected SQL instance. All BES server pairs will be failed over 
at once when the protected SQL instance is failed over (this is the 
instance hosting the configuration DB (i.e., BESMgmt)).

Log On Account

The WANSync service log on account must satisfy all of the following 
conditions:

Must be a member of the Domain Admins group -- if the Domain Admins 
group is not a member of the built-in domain local group Administrators, you 
must use an account that is

Must be a member of the local machine Administrators Group on all servers. 
If the Domain Admins group is not a member, add the account manually

If the account does not have built-in administrator permissions on all SQL 
Server instances, add appropriate permissions
 4    WANSyncHA for  BlackBerry Enterprise Server Operations Guide



BlackBerry HA Script
Important! If your company's security policy requires even more granular 
permissions than described, or any special circumstances apply to your case, 
please contact technical support to receive detailed instructions on the 
permissions required.

BlackBerry HA Script
The script referenced by this operations guide must be present on both SQL 
servers (or on all nodes, for SQL MSCS clusters) at the same path. By default, 
this script is provided in all versions of WANSync build 65 and above, and no 
additional action is required. The default location is C:\Program 
Files\XOsoft\WANSync\BBha.vbs.

The BlackBerry HA script controls and monitors BES services via RPC 
communication ports, make sure all required RPC communication ports are open 
between the SQL servers and all protected BES servers.

BlackBerry Configuration Database 
The BES configuration database (i.e., BESMgmt) contains all the BES 
configuration information. The WANSyncHA solution for BlackBerry protects, and 
utilizes this database, in order to provide BlackBerry high availability. If you use 
your current BES SQL instance (i.e. the one hosting BESMgmt) for any 
applications other than BES and still wish to provide BSE high availability, you 
must move the BES configuration database to a new dedicated SQL instance. It 
can be on the same, or different, server but must be a new dedicated SQL 
instance just for the BES configuration database. Once installed as a new named 
instance, WANSyncHA can be configured to protect only this instance, without 
affecting other SQL instances or WANSync(HA) scenarios running on the server 
(i.e., BES Servers can be switched over without also disrupting service to other 
SQL databases or instances on the server). For more information please review 
Independent BlackBerry SQL Instance.

To move the BlackBerry configuration database, please follow the official 
instructions provided by RIM on http://www.blackberry.com: How To - Move the 
BlackBerry Configuration Database from one server to another; Article Number: 
KB-03112.

This operation requires a brief restart for some of BES services, so it is 
recommended that this procedure is performed alongside the BES server 
configuration to reduce the total amount of downtime required.
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About MSDE
When editing the cfg file, ensure you change 'SERVER' to reflect the new 
dedicated named SQL instance for BES. For example: config file edit where the 
new dedicated SQL instance is on xooperations and is named xobessql:

; Name of Server to install the db

; Local machine can be specified as local

;

SERVER=xooperations\xobessql

After moving the BESMgmt database (i.e., finishing the above referenced KB) to 
the new server, you must restart the BlackBerry Manger before it will reconnect 
if it was open during the move process.

About MSDE
While this operations guide refers to a full featured SQL Server as the underlying 
database infrastructure, BES also supports working with a local MSDE 
installation by default. If this is the case with your configuration, simply regard 
all SQL references as MSDE references.

Non-Intrusive Installation
During installation and configuration of WANSyncHA, Microsoft SQL Server on 
the Master server continues working without any interruption. For the BES 
configuration and testing portion a brief BES downtime window will be required.

MSCS Clusters Hosting the SQL Database
With WANSyncHA, Installing on clusters is nearly identical to normal installation. 
To install on a cluster, simply enter the SQL Server Virtual Server Name when 
asked for the master or replica name.
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Chapter 2: BlackBerry Server Setup
 

This chapter describes how to set up a BlackBerry Enterprise Server for use with 
WANSyncHA.

Configuring the Master BES Server
Since WANSyncHA uses DNS redirection in order to redirect traffic from master 
to replica during a switchover, you must configure BES to access the 
configuration database through its FQDN DNS name (e.g., server.domain.com). 
This operation requires a brief restart for some of BES services, so it is 
recommended that you perform this procedure alongside the installation of the 
BES replica server. 

Keep in mind, when running multiple database instances on the same SQL server 
or in the case of a multi-function SQL server (i.e., one that serves other purposes 
besides hosting the BES database), you can create another DNS Host (A) record 
specifically for use with BES redirection and thus not disturb any other 
operations on the SQL server in question (for detailed instructions, see The 
BlackBerry HA Solution, Independent BlackBerry SQL Instance, and BlackBerry 
Configuration Database).

There are two places in which you need to perform this change:

The master BES server data sources (ODBC) configuration

The master BlackBerry server configuration

The Master BES Server Data Sources (ODBC) Configuration

To configure the BES Server data sources:

1. Open Start > Programs > Administrative Tools > Data Source (ODBC).
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Configuring the Master BES Server
2. Choose the System DSN tab; highlight BESMgmt from the name field and 
then click Configure.

3. In the server field, enter the full DNS name (FQDN) for your SQL server (and 
the named instance path if not installed as the default instance).

Important! Remember to use the alternate SQL server record you created 
if you are following Independent BlackBerry SQL Instance (for example, 
bbdb.xosoft.com/xobessql).
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Configuring the Master BES Server
4. Test the connection to ensure it was successful.

The Master BlackBerry Server Configuration

To configure the master BlackBerry Server:

1. Open Start > Programs > BlackBerry Enterprise Server > BlackBerry Server 
Configuration.

2. On the Database Connectivity tab, click on Change Database; then click on 
yes at the BlackBerry Server Configuration prompt.

3. In the SQL Server Name field, enter the Full DNS name for your server and 
the named instance path if not installed as the default instance.
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Configuring the Master BES Server
Important! Remember to use the alternate SQL server record you created 
if you are following Independent BlackBerry SQL Instance (for example, 
bbdb.xosoft.com/xobessql).

4. In the Database Name field, input the configuration database name (default: 
BESMgmt).
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Configuring the Master BES Server
5. When you click next, the screen should show your SRP provider address. 
Test to ensure SRP connection is OK.

6. Clicking next again shows your SRP login information. Test to ensure key is 
correct.

7. Make sure the mail server configuration is correct.
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Configuring the Master BES Server
8. After finishing configuration leave the Start Services selection box checked.

9. Test the SQL Connection.
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Install and Configure the Replica BlackBerry Server
10. Verify that BES on the master is functioning properly.

Install and Configure the Replica BlackBerry Server
Once the master BES server is configured and ready, you are ready to install the 
replica BES server. Please consider the following information when installing this 
server.

Important! Before starting the installation, stop the BES services on the Master 
BES server (for this server pair), and set them to 'manual'. This is done in order 
to avoid SRP Key conflicts (see SRP Connection Errors). Both master and replica 
BES services cannot be online simultaneously at any time.

To configure the replica server:

1. Start the BES installation process on your replica BES server. For the most 
part this installation process will be mostly identical to how you originally 
installed your production BES server.
BlackBerry Server Setup    13



Install and Configure the Replica BlackBerry Server
2. When prompted for the BlackBerry Server Name enter the same name as 
the master BES server. This allows the replica BES server to assume all 
configuration parameters and SRP information during a switchover. This is 
the name that appears in the master server's BlackBerry Manager.

3. When installing, make sure you enter the full DNS name (FQDN) of the SQL 
Server; at no point should the short name ever be used to reference the SQL 
server.

Important! Remember to use the alternate SQL server record you created 
if you are following Independent BlackBerry SQL Instance (for example, 
bbdb.xosoft.com/xobessql).
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Install and Configure the Replica BlackBerry Server
4. Verify that the Network test is successful.

5. Verify that the SRP key test is successful.

6. Make sure the mail server configuration is correct.
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Install and Configure the Replica BlackBerry Server
7. Leave the Start Services selection box checked.

8. After installation is complete, confirm that configuration information is 
correct and that BES on the replica is now functioning properly. If any 
configuration discrepancies exist between the original configuration and this 
one, or if BES is not functioning, you might have mistakenly entered a 
different server name and created a new server entry in the BES database. 
You should check the BlackBerry Server Configuration tool to see if the SRP 
Key defined is identical to the SRP Key of the master BES server. If not, 
remove the replica BES installation and install again with the correct Server 
Name (i.e., the same name as your master BES installation).

Important! BlackBerry Manager on the replica should show the same 
server name as it did on the master BES server.
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Install and Configure the Replica BlackBerry Server
The Replica BES Server Data Sources (ODBC) Configuration

To use the replica BES server data sources (ODBC) configuration:

1. Open Start > Programs > Administrative Tools > Data Source (ODBC).

2. Choose the System DSN tab; highlight BESMgmt and click Configure.

3. In the server field, enter the full DNS name (FQDN) for your SQL server (and 
the named instance path if not installed as the default instance).

Important! Remember to use the alternate SQL server record you created 
if you are following Independent BlackBerry SQL Instance (for example, 
bbdb.xosoft.com/xobessql).
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Install and Configure the Replica BlackBerry Server
4. Click Next and continue to test your connection; verify that it is successful.

Complete the Configuration

After finishing installation and testing, shut down the BES services on the replica 
server and set them to manual. You can now start the services on the master 
BES server, but leave the services set to manual. Test to ensure BES is 
functioning properly on the master server after starting all services.

While using this solution, the BES services on both master and replica server 
stay in manual start up mode to avoid any possible SRP conflicts (see SRP 
Connection Errors). It is suggested that you create a batch file or script allowing 
you to stop and start the BES services without having to stop/stop each service 
individually. This also means that you must start the services manually after 
each reboot on the active server.
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Install and Configure the Replica BlackBerry Server
Multiple BlackBerry Servers

If you are protecting multiple BES Servers, the previous procedures must be 
performed for all BES server pairs. When you are done preparing all BES servers, 
proceed to the beginning of this chapter.
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Install and Configure the Replica BlackBerry Server
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Chapter 3: WANSyncHA Setup
 

This chapter describes how to install WANSyncHA. Before proceeding ensure 
that you have properly installed the replica BES SQL instance per the The 
BlackBerry HA Solution section. It is also recommended to reference the 
Independent BlackBerry SQL Instance as well as the The Master BlackBerry 
Server Configuration.

Install WANSync Manager
Install WANSync Manager and the Remote Installation Wizard onto the machine 
from which the WANSyncHA scenario will be configured. The location of the 
Manager is not critical so long as it is accessible in the event of a disaster. The 
Manager is frequently installed on a server room or an administrator’s 
workstation.

Important! If the Manager is installed directly on either the master or replica 
servers, ensure that the XOsoft Engine is also installed. 
 
If you intend to use the XOsoft Remote Installer (recommended), the machine 
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Using the Remote Installation Wizard
on which you are running the remote installer should have .Net framework 2.0 
installed. The framework is required only on the machine running the remote 
installer wizard (GUI); the target servers do not have this requirement.

After the scenario is run it is cached on your master and replica servers. Once 
cached, you can download it to any installed WANSync Manager by selecting 
Download from the File menu (then enter the name of your master or replica 
server).

Using the Remote Installation Wizard
You can use the Remote Installation Wizard to deploy the XOsoft Engine to any 
number of servers, or cluster nodes, in one step. Alternatively, you can install 
the XOsoft Engine manually by running setup.exe directly on each server.

Important! If you install the XOsoft Engine using the remote installation 
wizard, you can skip the manual installation step under the sections Master SQL 
Server and Replica SQL Server.

Run the remote installation wizard either from the start menu or from the 
WANSync Manager Tools menu. When using the remote installation wizard, 
consider the following steps:
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Using the Remote Installation Wizard
Installation location - ensure that this path is correct and contains a valid 
WANSync setup package.
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Using the Remote Installation Wizard
Hosts selection - select the servers (or cluster) nodes to which you want 
to deploy the XOsoft Engine (you can add servers manually from the Host 
Name/IP Address box).
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Using the Remote Installation Wizard
User credentials - the user account that is used to install the XOsoft Engine 
on each target server (ensure that this account is a local Administrator on 
all target machines).
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Using the Remote Installation Wizard
Preinstall verification - click Next after all servers have reported success.

Install settings - select This Account and enter your WANSync service 
account domain\username and password (see The BlackBerry HA Solution 
for more details).

Important! Do not proceed without first setting the correct service account 
(see The BlackBerry HA Solution for more details).
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Using the Remote Installation Wizard
Ready to Install - confirm that all desired servers are listed and then click 
the Install button.

Installing - you can monitor the installation process from this screen.
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Master SQL Server
Report - in this last step you can view the full installation report and, 
optionally, save a copy (the XOsoft Engine now is installed on all selected 
servers or cluster nodes).

Master SQL Server
To install WANSyncHA on the master SQL server:

1. If you did not use the Remote Installation Wizard, install WANSyncHA on the 
master server.

Important! When installing WANSyncHA, use the log on account as 
described in The BlackBerry HA Solution. 
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Replica SQL Server
Note: If you installed under a different account than required, you can change 
it any time using the Windows services console: find the XOsoft Engine service 
and change the log on account. Then restart the service to apply the change.

2. If you have file level antivirus software installed, exclude the WANSyncHA 
installation directory and SQL database and log files from antivirus 
protection. 

3. If the master server is a cluster, perform steps 1 and 2 on all nodes. You do 
not need to switch over the SQL group during installation.

Replica SQL Server
1. If you did not use the Remote Installation Wizard, install WANSyncHA on the 

replica server. 

Important! When installing WANSyncHA, use the log on account as 
described in The BlackBerry HA Solution. 

Note: If you installed under a different account than required, you can 
change it any time using the Windows services console: find the XOsoft 
Engine service and change the log on account. Then restart the service to 
apply the change.

2. If you have file level antivirus software installed, exclude the WANSyncHA 
installation directory and SQL database and log files from antivirus 
protection. 
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Create a Replication Scenario
3. If the replica server is a cluster, perform steps 1 and 2 on all nodes. You do 
not need to switch over the SQL group during installation.

Create a Replication Scenario
Before creating a new scenario, ensure that you have installed SQL on the replica 
SQL server. Make sure to review The BlackBerry HA Solution and Independent 
BlackBerry SQL Instance (if it applies).

1. Open WANSync Manager. From the File menu, select New or click the New 
Scenario button. 

2. At the Welcome step click Next to Create New Scenario.

3. At the Scenario Type step select MS SQL, High Availability Scenario and, 
optionally, Replica Integrity Test for Assured Recovery.
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Create a Replication Scenario
Note: Learn more about Assured Recovery and how it can help ensure 
success through automatic testing. Please visit the Products menu at 
www.caxosoft.com or review the WANSync User Guide for more information.

4. During the Hosts step, name the scenario and input the server names for the 
master and replica SQL Server hosts.
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Create a Replication Scenario
Note: If either server is a MSCS cluster, enter the SQL Virtual Server Name 
as the master and/or replica name.

5. At the Master Configuration step, WANSync’s auto-discovery automatically 
detects all instances and databases on the master SQL server. By default, all 
instances are selected. You can deselect any of the instances or any 
non-system database within any instance. Ensure that the instance 
containing the BES configuration database is selected.
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Create a Replication Scenario
Important! If you are following the directions in Independent BlackBerry 
SQL Instance, please review before clicking Next.
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Create a Replication Scenario
6. The Root Directories step displays the data to be replicated. Click the Next 
button to continue.
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Create a Replication Scenario
7. The Scenario Properties step allows you to configure additional properties. 
No changes are required at this step. Click Next when ready.

Note: You can modify all the settings in this pane after the scenario is created. 
However, before changing any Spool properties (which are configured here), 
please review Spool Settings for configuration details.
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Create a Replication Scenario
8. The Switchover Properties step allows you to modify switchover parameters. 
As with the prior step, no changes are required. Click Next when ready.

9. The last step in Switchover Properties defines which steps are triggered 
automatically by WANSyncHA or triggered manually by the Administrator. 
Select manual for each option and then click the Next button.
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Create a Replication Scenario
Important! It is not recommended to set these options to automatic when 
using the BlackBerry solution to avoid any possible SRP key conflicts. See 
SRP Connection Errors for more information.
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Create a Replication Scenario
10. The Assured Recovery step is presented only if you selected this option in 
the Scenario Type step.
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Create a Replication Scenario
If scheduled testing is desired, double-click on the value for Schedule: the 
Assured Recovery hours screen opens allowing you to set a schedule for testing.

11. Scenario Verification checks many different parameters between the master 
and replica and servers to ensure a successful switchover. If any errors are 
reported you cannot continue until they are resolved. To retry verification 
click the Retry button. After the scenario is verified successfully, click Next 
to continue.
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Create a Replication Scenario
Important! Although the software allows you to continue with warnings, it 
is not recommended to do so. Resolve any warning situations before 
continuing to ensure proper operation of the application.
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Prepare the BlackBerry HA Server
12. The Run Scenario screen follows. Review configuration information and then 
choose Finish to continue with the BlackBerry HA configuration described in 
the next section.

Note: Do not click Run Now; click Finish. The BES-specific configuration must be 
completed before running the scenario.

Prepare the BlackBerry HA Server
After completing the initial scenario, you must perform several changes in the 
SQL HA scenario to support BlackBerry monitoring and switchover. As stated, 
there is no limit to the number of BES servers that can be protected, as long as 
they are all connected to the protected SQL server and each has a dedicated 
BlackBerry replica server that was installed as described in BlackBerry Server 
Setup. Please keep in mind that when a switchover occurs, all BES servers are 
switched over along with the SQL server. The SQL and BES servers function as 
a single unit to avoid inconsistencies and split-brain issues.

The BlackBerry High Availability script – bbha.vbs – is provided with the 
WANSyncHA installation, and resides in the program installation folder. In order 
to implement BlackBerry HA, you must configure the scenario with the provided 
script at various locations and with varying arguments.
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Prepare the BlackBerry HA Server
The bbha.vbs script requires three arguments, two of which can be multivalued:

Command – the action to be performed (monitor, start, stop).

Master – The Master server set in which the master SQL hostname is the 
first value followed by each master BES server name, separated by a 
semicolons.

Replica – The Replica server set in which the replica SQL hostname is the 
first value followed by each replica BES server name, separated by a 
semicolons.

Important! The BES server name in this case is NOT the server name 
shown in the BES Manager but rather the actual name of the server on which 
BES is running. The names can be the same but it’s possible they differ. Use 
the actual computer name in this case.

As stated, switchover initiated in the SQL scenario also affects all BES servers 
associated with it. To associate a BES server pair (master/replica BES) they must 
be included in the script arguments.

For example, if you want to implement a BlackBerry HA solution with two BES 
servers connected to the SQL server, where:

Master SQL Server Name – SQLSRV

Master BES Server 1 Name – BBSRV1

Master BES Server 2 Name - BBSRV2

Replica SQL Server Name - SQLREP

Replica BES Server 1 Name- BBREP1 (BES 'Server Name' identical but host 
name is different)

Replica BES Server 2 Name- BBREP2 (BES 'Server Name' identical but host 
name is different)

Then the master server set is: SQLSRV;BBSRV1;BBSRV2  
and the replica server set is: SQLREP;BBREP1;BBREP2

Keep in mind that the arguments are tied to each BES server pair, meaning that 
if the designated replica server for BBSRV1 is BBREP1, which was installed 
specifically to replace it (see BlackBerry Server Setup for details), they must be 
placed in similar locations in the script arguments. Also note that the first 
hostname must be the SQL server hostname.

The command argument is used to indicate what type of action – start, stop 
or monitor – the script is performing.

The Stop command is initiated when the Database is stopped on the active 
host pending a switchover

The Start command is initiated after the completion of a successful 
switchover and is responsible for bringing the BES servers online

The Monitor command is issued periodically (along with all is alive checks) 
and determines the status of active BES servers

In case of a BES host failure or service failure, the script returns an exit code 
notifying WANSyncHA of a failure status.
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Configure the BlackBerry HA Server
Configure the BlackBerry HA Server
To configure the BlackBerry HA Server:

1. In the right pane, click the Switchover tab.

2. Look under the Hosts category and check that the Master Full Qualified 
Name is the correct DNS name for the SQL Server to which the BES servers 
connect.

Note: If you created an additional record to be used solely for the BES SQL 
Instance (as described in Independent BlackBerry SQL Instance), remember 
to enter this record instead for proper redirection. For example, 
BBDB.xosoft.com.

3. Verify that under Network Traffic Redirection > DNS Servers IP, the 
addresses for all DNS servers are correct.

4. Change the DNS TTL from the default of 60 to 10 to allow faster propagation 
during switchover for the BES servers.

5. Verify SQL master and replica IP addresses.

6. Set the BlackBerry HA scripts:

Note: Note that the syntax in all cases is identical except for the /command 
argument. In order to avoid mistakes in entering the master and replica 
server sets, we recommend that you type in the syntax correctly once and 
then Copy/Paste the syntax, changing the /command parameter as 
necessary. Also note that you must use the actual computer names in the 
arguments listed here. 

Important! Do not use the BlackBerry Server Name or alternate name as 
defined in Independent BlackBerry SQL Instance; use the actual computer 
name in these arguments.

Under Is Alive > Check With > User Defined Scripts > Check Script on 
Stand-by host Set to On:

– Under Script Name enter the path for the windows script host command 
shell (typically, C:\Windows\System32\cscript.exe)

– Under arguments enter the path to the bbha.vbs script provided with 
WANSyncHA, enclosed in quotations (typically, “C:\Program 
Files\XOsoft\WANSync\bbha.vbs") followed by these parameters: 
/command: monitor /master: [Master Set] /replica: [Replica Set]

– For example, "C:\Program Files\XOsoft\WANSync\bbha.vbs" 
/command:monitor /master:SQLSRV;BBSRV1;BBSRV2 
/replica:SQLREP;BBREP1;BBREP2 

Under DB Management > User Defined Scripts > Stop DB script Set to On:

– Under Script Name enter the path for the windows script host command 
shell (typically, C:\Windows\System32\cscript.exe)

– Under arguments enter the path to the bbha.vbs script provided with 
WANSyncHA, enclosed in quotations (typically, "C:\Program 
Files\XOsoft\WANSync\bbha.vbs") followed by these parameters: 
/command: stop /master: [Master Set] /replica: [Replica Set]
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Run the Scenario
– For example: "C:\Program Files\XOsoft\WANSync\bbha.vbs" 
/command:stop /master:SQLSRV;BBSRV1;BBSRV2 
/replica:SQLREP;BBREP1;BBREP2

Under Action on Success > User Defined Script Set to On:

– Under Script Name enter the path for the windows script host command 
shell (typically, C:\Windows\System32\cscript.exe)

– Under arguments enter the path to the bbha.vbs script provided with 
WANSyncHA, enclosed in quotations. (typically, "C:\Program 
Files\XOsoft\WANSync\bbha.vbs") followed by these parameters: 
/command: start /master: [Master Set] /replica: [Replica Set]

– For example: "C:\Program Files\XOsoft\WANSync\bbha.vbs" 
/command:start /master:SQLSRV;BBSRV1;BBSRV2 
/replica:SQLREP;BBREP1;BBREP2

7. The final result should look similar to this screen:

Run the Scenario 
You are ready to run the high availability scenario. When the scenario starts, 
WANSyncHA synchronizes the data on the two servers. To start the scenario, 
select the Run button from the WANSync Manager's menu or tool bar.
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Run the Scenario
Before initiating synchronization and replication, WANSync verifies your scenario 
configuration. When verification is complete, WANSync Manager displays this 
message: Are you sure you want to run scenario “SQL Server Scenario?”. The 
top pane displays warning and error messages resulting from verification, if any 
exist.

Note: If any errors are displayed, you cannot run the scenario. Read all errors 
and warnings, then review the operations guide to see if you might have missed 
a critical step. If you do not manage resolving the errors or warnings yourself or 
by reviewing the operations guide, please contact technical support for further 
assistance.

Click OK to run the scenario. The following screen is displayed:

Leave the default values in the dialog box: the Block synchronization type with 
the Ignore same size/time files option unchecked. Click the Synchronize button.

Note: Block synchronization is best suited for database replication and most 
replication scenarios. If you wish to learn more about the other synchronization 
methods please refer to the WANSync User Guide.

Synchronization may take a while, depending on database size and network 
bandwidth between Master and replica. You will receive the following message 
in the event windows when the synchronization is complete: All modifications 
during synchronization are replicated.

At this point, real-time replication is operational and the high availability solution 
is installed and active.

Once the scenario is started, the bbha.vbs script monitors all BES services and 
will notify if any failures occur. The notification will look like this: Script 
C:/Windows/System32/cscript.exe executed; return code is 1.

To view script operation (and to confirm proper arguments) you can view the 
bbha log located in the scripts directory.
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Run the Scenario
Note: If you see the warning below or any other warning regarding the script, 
but the BlackBerry is functioning properly, it indicates that the script 
parameters, script configuration locations, network connectivity or 
administrative rights between the BES and SQL servers is incorrect or that the 
BES services on the master are not currently functioning properly. Stop the 
scenario and check the arguments and script path. If you are still not successful 
contact WANSync support to review the bbha.log file and troubleshoot the issue. 
If BES is showing as down and indicates SRP Connection errors please review 
SRP Connection Errors. 
 
Script C:/Windows/System32/cscript.exe executed; return code is 1.
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Chapter 4: Switching Over and Switching 
Back
 

This chapter describes the WANSyncHA switchover and switchback processes. 
You can initiate switchover and switchback once the scenario is up and running.

During a graceful switchover/switchback, when both servers are connected, 
WANSyncHA ensures that SRP key conflicts do not occur. However, if you 
switchover when the master is unavailable, the master BES services may 
continue running. In most cases they are stopped because they are set for 
manual start up mode. Before bringing the master server back on the network, 
double-check to ensure all BES services are stopped to prevent SRP key 
conflicts. BES services can run on only one BES server (master or replica) at a 
time for a SRP key conflict will occur. For more information, see SRP Connection 
Errors.

Switchover
To perform a switchover:

1. Open WANSync Manager and select the SQL scenario.

2. Select Perform Switchover from the toolbar, or select it from the menu.

3. Click OK on the Perform Switchover confirmation.

This initiates a switchover from the master SQL server to the replica SQL server. 
During the switchover, BES servers are sent stop and start controls to facilitate 
BES switchover alongside SQL. Detailed information about switchover processes 
are located in the event pane during the switchover.

Manual Switchback
To perform a manual switchback:

1. From WANSync Manager, select the SQL scenario.
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Manual Switchback
2. Click Run to start the scenario; WANSync detects that a switchover has 
occurred and prompts you that it will start a Backward scenario.

3. Once Re-synchronization is complete, select Perform Switchover from the 
toolbar, or select it from the menu.

4. Click OK on the Perform Switchover confirmation.

After switchback is completed, you can run the scenario again in its original 
(forward) state.
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Appendix A: Independent BlackBerry 
SQL Instance
 

WANSyncHA supports the independent transfer of a single instance (on a 
multi-instance or multi-function SQL server) to a replica server. This section is 
directed to administrators using a shared SQL server to host the BES 
configuration data, and wish to protect only the BES portion via WANSyncHA.

Implement the Solution
In order to implement this solution, several small additions to this HA solution 
are required. 

Please keep the following steps in mind as you follow this guide:

1. The SQL servers and additional instances should comply with the all the 
specifications described in the The BlackBerry HA Solution.
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Implement the Solution
2. An additional DNS Host (A) Record for the master SQL server is required. 
This DNS record is used for all BES HA purposes related to the SQL database. 
It should have a unique name and must be a host (A) record type; CNAME 
alias records are NOT supported. For example, in this case 
xooperations.xosoft.com is the real name of the SQL server and 
BBDB.xosoft.com is the new dedicated BES SQL record.

3. In BlackBerry Server Setup, ensure you use the additional record 
(BBDB.domain.com) and not the hostname (sqlserver.domain.com) for all 
SQL configuration settings in BES and ODBC. For example, instead of 
xooperations.xosoft.com.com\instancename use 
BBDB.xosoft.com\instancename.
 50    WANSyncHA for BlackBerry Enterprise Server Operations Guide



Implement the Solution
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Implement the Solution
4. When configuring the scenario, make sure that you only select the desired 
instance which contains the BES Configuration database.

5. In the Switchover tab configuration section, enter the additional DNS 
Record as the Master Fully Qualified Name - This is the record that is 
redirected during switchover. For example, in this case it’s BBDB.xosoft.com 
rather than the real SQL server name of xooperations.xosoft.com.

Performing these steps ensure that only the independent instance is switched 
over while other instances remain working on the master server. 
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Appendix B: WANSync Tips
 

This chapter provides you with helpful information concerning the application.

Spool Settings
The WANSync spool is a folder on disk where data to be replicated is backed up 
(i.e., spooled) if bandwidth is not sufficient to transfer the amount of changes in 
real-time. Data can spool due to temporary network disconnections, network 
congestion, or simply because the network bandwidth is not sufficient to transfer 
the amount of data changing over on the server. 

In addition to storing changes waiting on available bandwidth, spool space is also 
used as part of the normal synchronization process. Thus, some spool build up 
during synchronization is normal. 

Place the WANSync spool folder on a drive with relatively low use such as a 
dedicated volume or boot/system volume. Do not place the spool folder on a 
volume containing frequently accessed system (OS), user, or application data. 
Examples include volumes containing databases, shared files, or the system 
pagefile. By default, the spool folder is located in the tmp folder under the 
WANSync installation directory. The spool parameters, located in the properties 
tab (on both master and replica) or set with the New Scenario Wizard, 
determines how much disk space is available for the spool. In most cases the 
default values are sufficient. However, if you choose to change this value, it 
should be at least 10% of the total dataset size. For example, if you are 
replicating 50GB of data on a server you should ensure that at least 5GB of space 
is available for spool. Please note that this space is not pre-allocated.

Important! If you change the spool location, please remember to remove the 
new path from file level antivirus scans: both scheduled and real time.
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Recover Active Server
Recover Active Server
Important! When using the Recover Active Server feature, the BES services are 
not started automatically. After Recover Active Server finishes, the BES services 
are stopped on both master and replica BES server pairs, you must manually 
start the BES services on the appropriate server.

In certain circumstances, it may be necessary to forcibly make the master or 
replica server the active server without completing the data synchronization 
process. For example, if switchover occurred but no data was changed on the 
replica server. In this case you may even have newer data on the master server 
making it undesirable to synchronize data from the replica to the master server. 
WANSync allows for this option through a process called Recover Active Server. 
To use this option, ensure that the scenario is stopped, and select Recover Active 
Server from the Tools menu.

Note: While this option is the right choice in many situations, use it with caution. 
If used improperly data loss can occur. Normally WANSync will not allow 
switchover from one host to another until all data is synchronized. It is designed 
this way so users are not redirected to an out of date data set that then 
overwrites what may be a more current data set. When using Recover Active 
Server WANSync is forcing users to one server or the other with no regard as to 
which server has the correct data set. Thus, as an administrator, you must 
manually ensure that the server you are making active has the most up to date 
data set.
 54    WANSyncHA for BlackBerry Enterprise Server Operations Guide



Recover Active Server
Important! Recover Active Server is not available if you are using the Switch 
Computer Name redirection method.
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Read Only Web GUI
Select either Make Master Active or Make Replica Active depending onto which 
server you want to force into the active role.

Important! If a legitimate switchover in a disaster situation occurs and users 
are redirected to the replica server for any period of time, it is important to 
replicate all changes on the replica back to the master before making the master 
server active. Using Recover Active Server in such a situation results in loss of 
data.

Read Only Web GUI
The primary WANSync Manager may only be used by one Administrator at a 
time. Opening the GUI locks it for the current user making simultaneous use 
impossible. This is required to prevent conflicts. To allow simultaneous 
monitoring by any number of administrators WANSync also offers a read only 
Web GUI.
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Read Only Web GUI
To access the web GUI: 

1. Open your browser to http://masterservername:25000.

2. Enter a user account and password with administrative permissions on the 
master server.
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SRP Connection Errors
Important! There is no need to refresh the browser; the GUI refreshes 
automatically. You can monitor all parameters, statistics, and events from 
this window. 

SRP Connection Errors
AN SRP connection error occurs if at any point both the master and replica BES 
servers are connected to RIM’s server with services running. In this case, RIM 
generates an SRP key conflict and disables your SRP Key. 

When a conflict occurs, despite proper connectivity, the Windows event log 
reports repeated SRP connection errors. Contact RIM technical support to 
resolve this conflict. Let them know you were in the process of moving BES 
servers and accidentally brought both online simultaneously; ask them to 
re-enable your SRP key. There is no need to mention WANSyncHA since it is out 
of the scope of a RIM support call. The conflict is on RIM’s side and not something 
you can fix directly.
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